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2D Nonlinear 
Analysis of a 
Concrete Beam 
For LUSAS version: 23.0 
For software product:  Any Plus version. Bridge Plus version for the modelling 

described in the discussion at the end. 
With product options: Nonlinear. 

Description 
A nonlinear plane stress analysis 
is to be carried out on a model of a 
reinforced concrete beam.  

The reinforcement is provided in 
the lower face of the beam and has 
a total cross-sectional area of 
400 mm2. The superposition of 
nodal degrees of freedom assumes 
that the concrete and 
reinforcement are perfectly 
bonded. It is assumed that the self-
weight of the beam is negligible 
compared with the applied load 
and that the effects of any shear 
reinforcement can be ignored.  

Due to the symmetrical nature of the problem, only the left-hand span of the beam is 
modelled. The beam is simply supported at the left-hand end with a symmetry support 
at the right-hand axis of symmetry. A concentrated vertical load is applied to the top of 
the beam 1200mm from the left-hand end. The concrete section is represented by plane 
stress (QPM8) elements, and the reinforcement bars are represented by bar (BAR3) 
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elements. A nonlinear concrete cracking material model will be applied to the plane 
stress elements and a von Mises plastic material will be applied to the reinforcement 
bars.  

Note. This example, which requires lines and elements representing reinforcement 
bars to be defined explicitly, and along the boundary of each adjoining surface, was 
created prior to the availability of using parasitic bar elements (which do not require 
such geometry considerations). As such, the use of parasitic bars now greatly simplifies 
the modelling of reinforcement in 2D and 3D continuum models and supersedes this 
worked example. See the online help for more information. 

Units of N, mm, t, s, C are used throughout. 

Objectives 
The behaviour of the beam under cracking/yielding is to be examined by producing the 
following: 

 A Deformed Mesh Plot showing the final deformed shape. 
 A Load Displacement Graph for the top node on the axis of symmetry 

of the beam. 
 Stress contour plot showing the stress distribution in the beam. 
 Crack pattern plot showing the crack patterns produced. 
 Animation of stresses and crack patterns for selected load 

increments. 
 A graph of variation in stress through selected slice sections through 

the beam. 
 
Keywords 
2D, Inplane, Plane Stress, Bar Elements, Nonlinear Concrete Model, Element 
Selection, Concrete Cracking, Steel Reinforcement, Groups, Crack Patterns, 
Animation, Graphing, Load Displacement Curve, Slice Sections 

Associated Files 
Associated files can be downloaded from the user area of the LUSAS website. 

 2d_beam_nl_modelling.lvb carries out the modelling of the example. 
 
 

 

 
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Modelling 

Running LUSAS Modeller 
For details of how to run LUSAS Modeller, see the heading Running LUSAS 
Modeller in the Introduction to LUSAS Worked Examples document. 

Note. This example is written assuming a new LUSAS Modeller session has been 
started. If continuing from an existing Modeller session select the menu command 
File>New to start a new model file. Modeller will prompt for any unsaved data and 
display the New Model dialog. 

Creating a new model 
• Enter a File name of 2d_beam_nl 

• Use the default User-defined working folder. 

• Ensure an Analysis type of Structural is set. 

• Select an Analysis Category of 2D Inplane 

• Set Model units of N,mm,t,s,C 

• Leave the Timescale units as Seconds 

• Select a Startup template of 2D Plane Stress.  

• Ensure the Layout grid is set as None 

• Enter a Title of 2D Nonlinear Concrete Beam  

• Click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 
correct any mistakes made since the last save was done. 

Defining the Geometry 

 Enter coordinates of 
(0, 0), (1200, 0) and 
(1650, 0) to define two 
Lines representing the 
bottom of the left hand span of the beam. Click the OK button to finish. 

• Select both Lines just drawn by dragging a selection box around them. 

 


  

Geometry 
Line > 

By Coords... 
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 Enter a translation value of 25 in the Y direction to create the Surface which 
represents the concrete cover from the face of the beam to the centreline of the 
reinforcement.  

• Click the OK button. 

• Select the upper 
Lines of both of the 
Surfaces just drawn 
as shown. 

 Enter a translation value of 275 in the Y direction to create the Surface which 
represents the extent of the concrete above the centreline of the reinforcement.  

• Click the OK button. 

The model should appear 
as shown. 

 

Defining Groups 
To simplify the assignment of model attributes certain model features will be grouped 
together to allow selection by name in the  Treeview as opposed to selection by 
cursor in the graphics window. The 2 Lines representing the reinforcement bars are to 
be grouped together: 

• Ensure the 2 Lines representing the location of the reinforcing bars are still selected. 

 Enter Bars for the group name.  

• Click the OK button to complete creation of the group. 

The Surfaces representing the concrete are to be grouped together.  

• Holding-down the S 
key, (and noting that 
the cursor changes to 
show the type of 
feature that will be 
selected) drag a box 
around the whole model to select only the Surfaces defining the concrete. 

 Enter Concrete for the group name. Click the OK button to complete creation of 
the group. 

Geometry 
Surface > 

By Sweeping... 

 

Geometry 
Surface > 

By Sweeping... 

 

Geometry 
Group > 

New Group 

 

Geometry 
Group > 

New Group 
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Note. In this example, model attributes will be defined but not assigned to the model 
straight away. They will be assigned to the model later by making use of the Groups 
facility. 

Defining the Mesh Reinforcement Bars 
Separate mesh datasets need to be defined for the reinforcement bars and the concrete. 
For the reinforcement bars a uniform mesh is to be used to the right of the applied load 
and a graded mesh is to be used on the horizontal lines to the left of the applied load. 

The reinforcement bars will be modelled using Line meshes. 

• Set Generic element type to Bar and Interpolation order to Quadratic 

• Ensure the Number of divisions is set to 4 

• Enter the attribute name as Bar, quadratic order, divs = 4 

• Click the Apply button to create the attribute in the  Treeview and leave the 
dialog visible to allow additional datasets to be defined. 

• Change the Number of divisions to 6 and click the Spacing button. 

• Select a Uniform transition ratio of first to last element of 2 and click OK 

• Change the attribute name to Bar, quadratic order, divs = 6 graded 

• Click the OK button to finish to add the attribute to the  Treeview. 

These, and other attributes will be assigned shortly. 

Defining the Mesh Concrete 
The concrete will be modelled using a Surface mesh with Line mesh divisions to 
control the mesh density. 

• Select Plane stress, Quadrilateral, Quadratic elements.  

• Enter the attribute name as Plane stress quadratic 

• Click the OK button to add the attribute to the  Treeview. 

The default mesh density of 4 divisions per line is sufficient for the Surface to the right 
of the applied load. A graded line mesh will be created for use on the Surface to the left 
of the applied load. 

 

Attributes 
Mesh > 

Line… 

Attributes 
Mesh > 

Surface… 
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• In the  Treeview double click the Line mesh attribute name Null, quadratic 
order, divs = 6 graded 

The Line mesh properties dialog will appear. 

• Change the element type to None 

• Change the attribute name to Null, divs=6 graded 

• Click the OK button to add the attribute to the  Treeview. 

Defining the Geometric Properties 
• Select Bar from the drop down list and enter a value of 400 for the total cross 

sectional area of the reinforcement. 

• Enter the attribute name as Steel Area and click the OK button to add the attribute 
to the  Treeview. 

• Enter a value of 200 for the thickness. Leave the eccentricity blank.  

• Enter the attribute name as Beam Thickness and click the OK button to add the 
attribute to the  Treeview. 

Defining the Material Properties 
Steel 
Nonlinear steel properties will be defined for the reinforcing bar elements. 

• Enter Young's modulus as 210e3 and Poisson's ratio as 0.3 and leave the mass 
density field blank. 

• Select the Plastic check box, and then select the Plastic tab and enter an Initial 
uniaxial yield stress of 300 

• Select the Hardening option, click the Hardening gradient button and enter a 
hardening Slope value of 2121 with a Plastic strain of 1 

• Enter the attribute name as Nonlinear Steel 

• Click the OK button to add the attribute to the  Treeview. 

Attributes 
Geometric > 

Line… 

Attributes 
Geometric > 

Surface… 

Attributes 
Material > 

Isotropic… 
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Concrete 
Nonlinear concrete material properties will be defined for the Surface elements 
representing the concrete. 

• Ensure the concrete model Smoothed multi-crack (model 109) is selected. 

• Ensure that Creep model code None is selected. 

• Ensure that Shrinkage model code None is selected. 

• Select the Strain at end of softening curve radio button to add a row containing a 
default value to the grid and accept all the remaining default values. 

• Enter the attribute name as Nonlinear Concrete 

• Click the OK button to add the attribute to the  Treeview. 

Assigning Attributes to the Bars 
The various Line and Surface mesh, geometric and material attributes defined 
previously will now be assigned to the model using the groups that have been defined. 

• In the  Treeview right-click the group name Bars. Select the Set as Only Visible 
option. The features in the group will be displayed. 

• Select the left hand 
Line of the two 
Lines representing 
the bars. 

• Drag and drop the Line mesh attribute Bar, quadratic order, divs = 6 graded from 
the  Treeview onto the selected Line. 

•  Select the right 
hand Line of the 
two Lines 
representing the bars. 

• Drag and drop the Line mesh attribute Bar, quadratic order, divs = 4 from the  
Treeview onto the selected Line. 

• In the  Treeview 
double-click on the 
Mesh entry and 
select Show nodes.  

The Line mesh divisions will be seen defined with the spacing as shown.   

Attributes 
Material > 

Concrete 
(Nonlinear)… 
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• Select both Lines. 

• Drag and drop the geometric attribute Steel Area from the  Treeview onto the 
selected features. Click OK. 

• Drag and drop the material attribute Nonlinear Steel from the  Treeview onto 
the selected features. Click OK. 

Assigning Attributes to the Concrete 
• In the  Treeview right-click the group name Concrete. Select the Set as Only 

Visible option.  

The Lines in the Bars group will be made invisible, and the lines of the Concrete group 
will be made visible. 

• Select the left-top and left-
bottom Lines as shown. (Hold 
the Shift key down after 
selecting the first line) 

• From the  Treeview drag and drop the Line mesh attribute Null, divs=6 graded 
onto the selected features. 

• Select the whole model using the Ctrl and A keys together. 

• Drag and drop the Surface mesh attribute Plane stress quadratic from the  
Treeview onto the selected features. 

A graded mesh will be drawn on the 
left-hand Surface and a uniform 
mesh will be drawn on the right-
hand Surface. 

• With the whole model still selected, drag and drop the geometry attribute Beam 
Thickness from the  Treeview onto the selected features. Click OK. 

• With the whole model still selected, drag and drop the material attribute Nonlinear 
Concrete from the  Treeview onto the selected features. Ensure the Assign to 
surfaces option is selected for Analysis 1 and click OK 

The mesh on the Lines representing the cover to the centreline of the reinforcement 
needs to be altered. This is because they currently have a default Line mesh of 4 
divisions per line when only 1 division per line is required. 
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• Drag boxes to select the 3 
Lines as shown. (Remember 
to hold the Shift key down 
after the first line is selected 
so the other lines are added to the selection) 

• Drag and drop the Line mesh attribute Null, div =1 from the  Treeview onto the 
selected Lines. 

The mesh will be redisplayed with the revised mesh pattern. 

Making all groups visible 
• From the  Treeview right-click the group heading name beam_nl.mdl. Select the 

Set as Only Visible option. Click Yes to act on subgroups as well.  

All features in the model will now be 
displayed as shown. 

Supports 
When using the Standard template, LUSAS provides the more common types of 
support by default. These can be seen in the  Treeview. The beam is to be simply 
supported in the Y direction at the left-hand end and a horizontal restraint in the X 
direction is required to satisfy the symmetry requirements at mid-span. 

• First, select the lowest 
point at the left hand 
end of the model as 
shown. 

• Drag and drop the 
support attribute Fixed in Y from the  Treeview onto the selected point. Ensure 
the Assign to points and All analysis loadcases options are selected and click OK 

• Then, drag a box around the 2 lines at the right hand end of the model as shown. 

• Drag and drop the support attribute Fixed in X from the  Treeview onto the 
selected Lines. Ensure the Assign to lines and All analysis loadcases options are 
selected and click OK 
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Loading 
A single concentrated load is to be applied to the Point at the top of the beam. A unit 
load will be applied and the load factor in the nonlinear control will be used to control 
the magnitude of loading. 

• With Point loads and the Concentrated option selected click Next 

• Enter a Concentrated load in Y Dir loading value of -5000 

• Enter the attribute name as Point Load and click Finish 

• Select the Point on the 
top of the beam as 
shown. 

• Drag and drop the 
loading dataset Point 
Load from the  Treeview onto the selected Point. 

• Ensure the Assign to points option is set and click OK to assign the load to 
Analysis 1, Loadcase 1. 

Nonlinear Control 
Nonlinear analysis control properties are defined as properties of a loadcase. The 
nonlinear analysis is to be terminated when the beam deflection at mid span reaches a 
limiting value. 

• Select the point shown. 

• In the  Treeview 
ensure the Analysis 1 
entry is expanded, then 
right-click on 
Loadcase 1 and from the Controls menu select Nonlinear & Transient 

Attributes 
Loading... 
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The Nonlinear & Transient dialog will appear: 

 

• Select the Nonlinear option and set Incrementation to Automatic 

• The load to be applied to the model is the concentrated load previously defined and 
assigned to the model multiplied by the starting load factor. Set the Starting load 
factor to 0.01 to apply a very small amount of load initially. 

• Ensure the Max change in load factor is set as 0 to signify no limit and to let 
Solver use load factors according to how the solution is progressing. 

• Change the Max total load factor to 0 because the solution is to be terminated 
once the limiting displacement at mid span has been reached for a particular loading 
increment. 

• Ensure the number of Iterations per increment is set to 4 
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Note. If the number of iterations on the previous increment is less than the desired 
number, the next load increment will be increased (up to the maximum change in load 
increment). If the number of iterations is less than the desired number, the next load 
increment will be reduced. 

• In the Solution strategy section of the dialog, ensure the Maximum number of 
iterations is set to 12 

• Leave the Residual force norm as 0.1 and the Displacement norm as 0.1 so 
convergence of the solution at each load increment will be achieved when the out of 
balance forces are as less than 0.1% of the reactions and the iterative change in 
displacements is less than 0.1% of the displacements for that load increment. 

• In the Incrementation section of the dialog, select the Advanced button. 

 

• Ensure that the Incrementation by arc-length control is Off. 

• For termination criteria select the Terminate on value of limiting variable option. 

• The point number of the previously selected point (this may differ depending on 
how the model was created) will appear in the Point number drop down list. 

• Set the Variable type to V to monitor the deflection at the selected point in the Y 
direction. 

• Enter a value of -3 (minus 3) so the analysis is terminated when the central 
deflection reaches this value. 

• In the Step reduction section ensure that the Allow step reduction option is 
selected. 

 
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• Click OK to return to the Nonlinear & Transient dialog. 

• Click OK again to set the loadcase properties. 

One additional setting is required for this analysis to ensure no element mechanisms are 
induced as the material yields. 

• Select the Options tab. 

• Click on the Element Options button and select the Fine integration for stiffness 
and mass (structural) option. 

• Click the OK button to return to the Model Properties dialog.  

• Click the OK button to finish. 

Save the model 
The model is now complete, and the model data is to be saved before an analysis is run 
using the LUSAS Solver.  

 Save the model file. 

Running the Analysis 
 Open the Solve Now dialog and press OK to run the analysis. 

During the analysis 2 files will be created: 

 2d_beam_nl.out this contains the statistics of the analysis, for example how 
much disk space was used, how much CPU time was used, and any errors or 
warning messages from LUSAS, and so on. Always check the LUSAS output 
file for error messages. 

 2d_beam_nl.mys this is the LUSAS results database which will be used for 
results processing. 

 
Note. Warnings will be written to the text output window during this analysis. 
Warnings are not to be confused with errors which normally stop an analysis from 
being run. The warnings are written to advise you of modelling-related issues that are 
found during the analysis and of the steps LUSAS has taken (if any) to allow the 
analysis to continue. 

If the analysis is successful... 
Analysis loadcase results are added to the  Treeview. 
 

File 
Model Properties… 

File 
Save 

 
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If the analysis fails... 
If the analysis fails, information relating to the nature of the error encountered can be 
written to an output file in addition to the text output window.  Select No to not view 
the output file.  Any errors listed in the text output window should be corrected in 
LUSAS Modeller before saving the model and re-running the analysis.  

Rebuilding a Model  
If it proves impossible for you to correct the errors reported a file is provided to enable 
you to re-create the model from scratch and run an analysis successfully.  You may 
download this file from the user area of the LUSAS website. 

 2d_beam_nl_modelling.lvb carries out the modelling of the example. 
 

 

 Start a new model file. If an existing model is open Modeller will prompt for 
unsaved data to be saved before opening the new file. 

• Enter the file name as 2d_beam_nl 

• Use the default User-defined working folder. 

• Ensure an Analysis category of 2D Inplane is set. 

• Click the OK button. 

Note. There is no need to enter any other new model details when a script is run to 
build a model, since the contents of the script will overwrite any other settings made. 

 To recreate the model, select the file 2d_beam_nl_modelling.lvb that was downloaded 
and placed in a folder of your choosing. 

 Rerun the analysis to generate the results. 

Viewing the Results 
Analysis loadcase results are present in the  Treeview. 

Changing the Active Results Loadcase 
• In the  Treeview the last load increment Increment 10 Load Factor = 5.35 

should be already Set Active. 

 
File 

New… 

 
File 

Script > 
Run Script... 
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Deformed Shape 
• In the  Treeview turn off 

the Geometry, Attributes and 
Mesh layers by right clicking 
on each entry and selecting 
the On/Off option. 

 

Creating a Load versus Displacement Graph 
A graph of displacement at mid-
span is to be plotted against the 
applied load. To do this a node on 
the line of symmetry is selected: 

• With the Deformed mesh layer visible, select the top node on the axis of symmetry 
as shown. 

Using the Graph Wizard 
The graph wizard provides a step-by-step means of selecting which results are to be 
plotted on the X and Y axes of the graph. The X axis is always defined first. 

• Ensure the Time history option is selected and click the Next button. 

• Ensure the Nodal results is selected and click Next 

• Select entity Displacement for component resultant displacement RSLT 

• The node number selected earlier will be displayed in the Specify drop-down list. 

• Click the Next button. 

The Y axis results to be graphed are now defined. 

• Select the Named option and click Next 

• Select Total load factor from the drop down list. 

• Click the Next button. 

• Leave all title information blank and click the Finish button to display the load 
deformation graph. 

 

 

Utilities 
Graph Wizard... 
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Note. Graphs can be modified using the right hand mouse button in the graph 
window and selecting the Edit Graph Properties option.  

 Close the graph window. 

• In the  Treeview turn off the Deformed mesh layer and turn on the Mesh layer. 

Maximum Principal Stress Contour Plots 
• With no features selected, click the right-hand mouse button in a blank part of the 

graphics window and select the Contours option to add the contours layer to the  
Treeview. 

The properties dialog will be displayed. 

• Select entity Stress - Plane Stress, Component of stress in the x direction, SMax, 
and Averaged nodal contours. 

• Click the OK button to display contours of stresses for the final load increment. 

 

 
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Viewing Crack Patterns 
• With no features selected, click the right-hand mouse button in a blank part of the 

graphics window and select the Values option to add the values layer to the  
Treeview. 

The properties dialog will be displayed. 

• Select Concrete Results contour results of type Crack/crush 

• Click the OK button to display the cracking pattern for final load increment 
superimposed onto the stress contours. 

 

Animating the Results 
As an alternative to viewing results individually for each loadcase, the change of stress 
due to the increasing load increments can be animated instead. To ensure consistent 
contour values throughout the animation the interval, and the maximum and minimum 
values for the range of contours is to be specified. 

• In the  Treeview double-click on the Contours layer.  

The contour properties will be displayed. 

• Select the Appearance tab and for the Classic contour range press the Set button 

• Click the Interval option and set the contour interval as 0.5 

• Click the Maximum button and set the maximum value as 3 

• Click the Minimum button and set the minimum value as -2 

• Click the OK button to return to the parent dialog, and OK to redisplay the stress 
contours using the new contour range. 
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Using the Animation Wizard 
• Select the Load History option and click the Next button.  

• Select the All loadcases option and select the Finish button to create the animation 
sequence. 

 

Note. The buttons at the bottom of the window may be used to slow-down, speed-up, 
pause, step through frame by frame, or stop the animation. 

Note. To see the animation window in isolation use the Window > Layout > 
Multiple documents menu option. 

Saving Animations 
Animations may be saved for replay in Windows animation players. 

• Ensure the animation window is the active window. 

• Browse to your projects folder and enter beam_nl for the animation file name. An 
.avi file extension is automatically appended to the file name. Click Save 

Note. Animations can be compressed to save disk space by changing the 
Compression Quality. Reducing the quality will, however, result in a lower definition 
image. It is also possible to reduce file size by setting smaller dimensions on the first 
page of the Animation Wizard. 

 Close the animation window, choosing not to save changes. 

Tools 
Animation Wizard... 

 
 

File 
Save As  AVI... 

 
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Creating a slice section of results 
In this example a graph is to be plotted of the variation in stress through the specified 
section of the beam. The X axis values of distance are defined by the section slice. The 
Y axis results are specified from the graph wizard dialog. 

• If necessary, return the model to the default starting view by clicking  
on the status bar at the bottom of the graphics window. 

• Ensure the Snap to grid option is selected and a grid size of 100 is specified. 

• Click the OK button. 

• Using the screen ruler as a guide, click and drag the cursor as shown to define the 
location of a section slice through the beam at a distance of 1600 from the left-hand 
end. 

 

• For the loadcase and extent option accept the default of the current loadcase and 
click Next 

• Select Stress results for Stress SMax and click the Next button. 

• Leave all title information blank. 

• Click the Finish button to create the graph of stress through the section of beam.  

 

 

 

 

 

Utilities 
Graph Through 2D 



2D Nonlinear Analysis of a Concrete Beam 

 20 

 

Adding Additional Results to a Graph 
• Re-select the window containing the results contours. The cursor will still be in 

section slice mode.  

• Using the screen rulers as a guide, click and drag the cursor as shown to define the 
location of a section slice through the beam at a distance of 1000 from the left-hand 
end. 

 

• For the loadcase and extent option accept the default of the current loadcase and 
click Next 

• Select Stress - Plane Stress results for Stress SMax and click the Next button. 

• In the ‘Include existing graphs’ panel select the check box for Graph 2. 

• Click the Finish button to see the results for the second slice section alongside the 
results for Graph 2. 

Window 
LUSAS View: 
beam_nl.mdl 
Window 1 
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 Close the graph window. 

Plotting Crack Width Contours and Values 
Crack width values as calculated by the use of the Smoothed Multi Crack Concrete 
Model can be plotted in contour and value form: 

• Double-click the Contours layer name in the   Treeview. 

The properties dialog will be displayed. 

• Select entity Concrete Results – Plane Stress for component of stress in the x 
direction, CWMax 

• Select the Appearance tab and for the Classic contour range press the Set button 

• Deselect the Maximum button. 

• Deselect the Minimum button. 

• Set the contour Interval to be 0.005 

• Ensure the Value to pass through is set to be 0.005 

• Click the OK button to redisplay the stress contours using the new contour range. 

• Press Yes to confirm the Values layer will be adjusted to match. 

Note. Contouring of crack width values effectively shows the elements affected by 
cracking and identifies those elements where the maximum crack widths occur. This is 
done using unaveraged, or unsmoothed values at nodes. To see the actual values of 
crack width within elements (at the locations where the Crack/crush patterns were 
plotted earlier in the example), values for gauss points need to be plotted. 

 
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To see the crack width values: 

• Double click the Values layer name in the  Treeview. 

• With the Values Results tab active, ensure the following are selected: Concrete 
Results- Plane Stress of Component CWMax at Location Gauss Point. 

• Select the Values Display tab, ensure the Symbols and Values are checked, ensure 
only Maxima is selected, to show the top 10% of results. Leave the font angle set 
to 0 degrees.  

• Click OK to update the display and show the actual crack width value calculated at 
gauss points within the element. Zoom-in to see more detail. 

 

• Save the model prior to the next operation. 

Modifying the model to plot crack widths to EN1992-1-1 
Reinforcement bar attributes may alternatively be used to model the steel reinforcement 
in reinforced concrete. Reinforcement bar attributes are similar to geometric line 
attributes but need to be assigned to lines meshed with bar elements for a chosen 
analysis to enable a crack width calculation to EN1992-1-1 to be carried out.  

A linear steel material model (rather than a nonlinear one) is also required to be 
assigned to the lines representing the steel reinforcement because of the steel strains 
used in the calculations. 

First, save the model with a new name: 

• Click OK to not save results. 

• Save the model with a new name of 2d_beam_nl_en1992.  

• In the  Treeview turn on the display of the Geometry and Mesh layers. 

File 
Save… 

File 
Save as… 
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Assigning linear steel properties 
Because a startup template of ‘2D Plane Stress’ was specified when creating the initial 
model, a ‘Steel’ material will be present in the  Treeview. 

• In the model view window, select the two lines representing steel 
reinforcement. 

 

• From the  Treeview drag and drop Steel (Mild Steel : Steel | Structural) 
onto the selected features and click OK. 

Defining reinforcement bar attributes 
Reinforcement bar attributes may be defined for a single reinforcing bar (termed a 
‘Discrete bar’), as would be used in a 3D model, or be defined with suitable properties 
to represent a bundle or simplified arrangement of bars (termed ‘Equivalent bars’) as 
would be used typically in a 2D plane strain analysis – and as required by this example. 

• Enter a Bar area of 400 

• Enter a reinforcement cover of 20 

• Enter a Bar diameter of 16 

• For Reinforcement type choose 
Equivalent bars from the droplist 
provided. 

• Enter breadth / spacing of bars to be 
150 

• Enter a Steel area factor of 1 

• Enter a name of Two dia 16 bars 
and click OK 

 

Assign the reinforcement bar attributes 
With the two lines representing the bar reinforcement still selected: 

Attributes 
Geometric > 

Bar 
Reinforcement… 
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• From the  Treeview drag and drop Two dia 16 bars onto the selected 
features and click OK. 

• Click in a blank region of the view window to deselect the lines. 

Running the Analysis 
 Open the Solve Now dialog and press OK to run the analysis. 

Viewing the Results 
• In the  Treeview the last load increment Increment 10 Load Factor = 5.35 

should be already Set Active. 

• In the  Treeview turn off the display of the Deformed mesh layer. 

Plotting Crack Widths to EN1992-1-1 
Crack width contours can be plotted along the bar elements (actually on the surface of 
the fleshed bar section) corresponding to the steel strains used in the calculation, and 
not on any concrete face or surface in the model. This visualisation method is used 
because the approach used in EN 1992-1-1:2004 to calculate crack widths is generally 
unclear as to where the crack width calculation applies. 

• Click OK to accept the default values seen on 
the dialog. 

The model view window will update to show 
results for crack widths to EN1992-1-1. 
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• Ensure that both the Contours and Values layers are showing results for entity 
Crack widths EN1992-1-1 and component Maximum Crack Width 

The contours and values are re-computed if a different loadcase is set active. 

Save the model. 

 

This completes the example. 
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